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Section 1: Backup your current configuration

A. Backup your License Certificates

1. Save your NetReport license at:
C:\Program Files\Click and DECIDE\NSI\_license.cert (by default).

B. Backup NSI Log Acquisition Configuration

1. Start the Management Console: Start>All Programs>Click and DECIDE>Network Security
Intelligence>Management Console.

Note: the default login/password is now admin/admin.

2. Navigate to Click and DECiDE/localhost (or NetReport/localhost for earlier version).

3. Click on Backup.

= Click and DECiDE Management Console - [Console Root'.Click and Decidelocalhost]
ﬁ File  Action ‘iew Favorites  Window  Help | - |ﬁ'|l|
EENEIE]
[_ Consale Rioot Port : 12343 |
S| 9 Click and Decide
B g localhost Shared Secret : LI
Packages Server
o uLa If your modify the above parameters, click here to reconnect to the configuration server using the new
Agents settings.
g Log ¥ault This will overwrite recent XML configurations that have not been saved.
[ Backy

Reload from Configuration Server as

Click here to restore the last configuration of the configuration server.
This will overarite recent XML configurations that have not been saved.

Current Configuration

Backup the

Click here to save a backup of your current configuration.
A backup will be made and become available in the Backups branch.

Erack

|D0ne | |

4. Save the new folder named YYYYMMDD-HHMM-user-vNNNN created in
C:\Program Files\ Click and DECIiDE\NSI\ConfigurationBackup (by default).

5. Close the Management Console.
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C. Backup NSI Web Portal Configuration

1. Startthe Administration Manager: Start>All Programs>Click and DECiDE>Administration
Manager.

2. Goto File>Backup Security Database...

& Click and DECIDE Administration Manager - = X
;| File | Edit View Tools Help

-

Mew

ol |
|

Check Database Security... I_?

|G} | Update Database Security...

[ M REEEE

Export Report... Mo item selected.,

| ed SOL

| Backup Diatabase Security... ver

Import Windows Users and Groups...

Exit

|L__' Data Sources[ %User Groups E; Users E Menu % Authentications
Backup Database [ CAPS| NUM| SCRL| .:

3. Save the Security Database configuration into a .bck file.
4. Close Administration Manager.

5. Save your own Click and DECIDE BAI projects (*.wfv files) created with Click and DECIDE Builder. We
recommend to put these file in the MyProject folder located at:
C:\Program Files\Click and DECIDE\BAI\Runtime_Projects\My Projects (by default).

6. Save the external files (for example, the images) used by your own Click and DECIDE BAI projects. We
recommend to put these file with the other image files in the Runtime_projects folder located at:
C:\Program Files\Click and DECIiDE\BANRuntime_Projects (by default).

7. Save the standard reports and cubes (if applicable) respectively located in:
C:\Program Files\Click and DECIDE\BAI\Runtime_Projects\enu (by default) and
C:\Program Files\Click and DECIiDE\BAIN\Runtime_Projects\utilities (by default) and
C:\Program Files\Click and DECIDE\BAI\Runtime_Projects\cubes (by default).

8. Save your customized menus (if applicable): these are the *.wmu files in the Runtime_projects folder
located at:
C:\Program Files\Click and DECIiDE\BAINRuntime_Projects (by default).
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9. Save the scheduled tasks configuration file d7tasks.xml located at:
C:\Program Files\Click and DECIiDE\BANd7tasks.xml (by default).

10. Save your own script (if applicable) which are located in:
C:\Program Files\Click and DECIiDE\BANTaskScripts (by default).

D. Backup the database files

Whereas it does not concerns NSI Configuration we strongly recommend to regularly backup the netreport
database. Please consult your Database Administrator for this task.
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Section 2: Restore your configuration

A. Enter your License Certificate

1. Launchthe Log Source Configuration: Start>All Programs>Click and DECiDE>Network Security
Intelligence>Management Console.

2. Click Settings... in the License Certificate section.

Click and DECIDE Configurator - License Certificate

ﬂ .'I ~ Mo License installed for Click and DECIDE. ;I
Y o ‘B Flease contactyour supplier to receive the appropriate license
—  reftificate.

Canicel Change... | Help |

3. Click Change...
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4. Select the License Certificate we sent you for Click & DECIDE - NSI 10.1.2.

Click and DECIDE Configurator - License Certificate

ﬂul-' This Cedificate was delivered to: ;I
L NET REPORT
This License autharizes yvou to use version of:

Click and DECIDE - for NSl Enterprise

Business Application Intelligence
Enterprise Edition w101

Builder 1 CAL useris)
WehPortal aCAL useris)
WehPuortal A Concurrent users)(Client Access)
Scheduled Tasks Ves
Froject Types S Projects (Execute onhd

mMaintenance Agreement  Walid antil 1731722011
Hetwork & Security Intelligence
Enterprise w101
Daily Records 200000
Maintenance Agreement  Walid antil 1731722011

This Certificate will expire on: 1312011
Internal Lise Only

k. Caricel
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5. Click OK.

i .Click and DECIDE - for MSI Enterprise Configurator

— Device Type Inztalled

T_I,Ipel Murnber of Devices |

Click and DECIDE - for NSI Enterprise Configurator - Add Device

Select the device bppe that you want to add.
~1 -
| Device Type | Cateqory - ]
Aladdin e5afe E-mail Cantent Filkering
—  |Aladdin e5afe v5.2 Content Filkering —
—1 |Apache Weh Site =
ARKOOM Mebwork, Security Firewall; Prosy; Intrugion Prevention System b
Blue Coat Prowy: Cantent Filkering ]
L |Check Point [Real Time] Firemall ||
1 |Check Paint Firessall [Command Line Flat File]  Fireweall |
' |Check Paint Firewall [GLI Flat File) Firevaall
Check Paint Syzlog Tk Firgwall ]
Cizco Firewalls Firewaall
~ |Cigco [ranPart-C Content Filkering; E-mail B
Y |Cizco lronPort-5 Promy —
Clavizter Firewaall
Demo Firewwall; Prosy: Intruzion Prevention System ]
| Derny All [ntrugion Prevention System: wWeb Site _ILI =
1 4] | » -
k. I Cancel | Help | ]

—License Certificate

\ﬁﬂ I iew or update vour current Click and DECIDE License Certificate. =
M W Settings...
L,

] Cancel Apply | Help |

6. Click Cancel.

7. Click Cancel and exit the Log Source Configuration.

B. Restore the WebPortal Configuration

1. Restore your own Click and DECIDE BAI projects (*.wfv files) created with Click and DECIDE Builder
(see Section 1.C.5). We recommend to put these file in the MyProject folder located at:
C:\Program Files\Click and DECIDE\BAI\Runtime_Projects\My Projects (by default).

2. Restore the external files (for example, the images) used by your own Click and DECIDE BAI projects
(see Section 1.C.6). We recommend to put these file with the other image files in the Runtime_projects
folder located at:

C:\Program Files\Click and DECIDE\BAI\Runtime_Projects (by default).
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Note: Do not replace any existing files. Complete the guide first and then modify the files you
think are appropriate.

3. Restore the standard reports and cube (see Section 1.C.7) located in:
C:\Program Files\Click and DECIDE\BAI\Runtime_Projects\enu (by default) and
C:\Program Files\Click and DECIDE\BANRuntime_Projects\utilities (by default) and
C:\Program Files\Click and DECIDE\BAI\Runtime_Projects\cubes (by default).

4. Restore your customized menus (see Section 1.C.8) in the Runtime_projects folder located at:
C:\Program Files\Click and DECIiDE\BANRuntime_Projects (by default).

Note: Do not replace any existing menu. Complete the guide first and then modify the menu with
the Menu editor.

5. Locate the Security Database backup file (.bck) from Section 1.C.3 on your hard drive.

6. Double click on the file. Administration Manager asks if you want to restore the Security Database.

Click and DECIDE Administration Manager B2

\::) Do you want to restore the database (compatibility between version not supported) From the backup of 5/4/2010 4:57:48 PM

7. Click Yes.
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8. Click Update Security icon

Network Security Intelligence | KBA

i File Edit Wiew Tools Help

o $ aBl9 e @I BBIHME

2] Click and DECIDE Adrniniskration Manager - =X

M |G Update Security |
Me Update Security |Path

— MefHeport FeretReport_Directory aiMNetReport,wmu

“aMetReport_Direcks WMy Menu, wmu

1 |

L__j Data Sources %User Graups E; Users |§ Menu | 7

E MetReport Utiities  %eMetReport_Directary \MNetReport Ukilities  wru
E MetReport Static  %MetReport_Directory % MetReport Static.wru
E Alert Management  %aMetReport_DireckorySaietReport Alerts, wmu

L |IT | i

Mame: |M ukd e

Path: I%N etFeport_Directony .. | Edit

Update Security

| caps| um| ScRL|

9. Click OK.

10. Close Administration Manager.

C. Restore your custom NSI Log Sources Configuration

1. Copythe YYYYMMDD-HHMM-user-vNNNN folder (see Section 1.B.4) to the folder:
C:\Program Files\Click and DECIiDE\NSI\ConfigurationBackup

2. Open the Management Console:

Start>All Programs>Click and DECiDE>Network Security Intelligence>Management Console.

Note: the default login/password is now admin/admin.
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3. Navigate to Click and DECiDE/localhost/Backups/User Backup YYYY-MM-DD HH:MM v.NN.NN (or
NetReport/localhost/Backups/User Backup YYYY-MM-DD HH:MM v.NN.NN for earlier version).

F= Click and DECIDE Management Console - [Console Root',Click and Decide' localhost,Backups',User Backup 2011-03-11 17:41 v.11.00]
a File  Action ‘iew Faworibes  Window Help |;|i|l|
== H
[ Consale Root E . . -
= @ Click and Deide Check Point {(Real Time)
El by locahost . Event Scheduler
el Packages Server
o ULA @ Flat File Parser
o Agents
3# Log Yaulk % Microsoft WM
Bl ¥ Backups J
¥ Wizard Backup 2011-03-11 12:24 v.11.0 2 . NetReport Communication
f',/ ‘izard Backup 2011-03-11 12:13w.11.0
f’:, User Backup 2011-03-11 17:41 +.11.00 g‘; Remote Microsoft Wi
SHNMP Trap Listener
ol Syslog Parser
E Log Vault
i 57
Restore Backup
Click here to replace your current configuration by restoring this user configuration
backup.
e . Y
| - ESIULE -
L ey
| | o] =

4. Click Restore.

MNet Report |

Do vwou really wank to restare the 'User Backup 2011-03-11 1741 w. 11.00°
backup for the localhost’ configuration server?

i}
5. Click Yes.
MNek Repork |
The 'User Backup 2011-03-11 17:41 . 11.00" backup for the 'localhost’
configuration server has been successfully reskored,
6. Click OK.
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7. Navigate to Click and DECiDE/localhost/ULA (or NetReport/localhost/ULA for earlier version).

8. Click Apply Changes.

B= Click and DECIDE Management Console - [Console Root',Click and Decide'localhost',ULA*]

ﬁ File Action ‘iew Favorites  Window  Help |_|ﬁ'|l|

e 2@ Hm

L1 Consale Root

Bl Q) Click and Deide =Click and Decide/localhost/ULA<
= “ localhost : : A aof . E 2
Packages Server Filter Definitions (Summary) s
o LA This ULA caontains filter definitions for 5 different Agents
it Click and
Log Yault® . 45 Field Definitions, 12 Actions, 1 Dictionary Entries, 1 Rules Groups
B ¥ Backups Decide Alert
=, .
E’ Wizard Backup 201101311 CI"?k £ N 39 Field Definitions, 10 Actions, 4 Dictionary Entries, 3 Rules Groups
¥ Wizard Backup 2011-03-11 Decide Audit
M i User Backup 2011-03-11 17
2 5 userBackup Database 0 Field Definitions, 8 Actions, 1 Dictionary Entries, 1 Rules Groups
Management

% EngineEvent 22 Field Definitions, 42 Actions, 2 Dictionary Entries, 3 Rules Groups

=-. Fortinet
wmw FortiGate UTM

93 Field Definitions, 46 Actions, 13 Dictionary Entries, 12 Rules Groups

Applying Changes

Click here to save all your changes for the filter.
All the changes you have made locally will be sent to the filter,
They will become active at the end of all record source processing.

v

Configuration

1 | i

9. Navigate to Click and DECiDE/localhost/Log Vault (or NetReport/localhost/Log Vault for earlier
version).
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10. Click Apply Changes.

a File  Action ‘iew Favorites  Window  Help |;|i|l|

]
[_1 Consale Rioot
= @ Click and Decide
El g locahost
Packages Server
[# < LA
Agents Loy File Spies
Log ¥ault*
B g Backups Gurrent Spied Directory List
¥, Wizard Backup 2011-03-11

¥4 Wizard Backup 2011-03-11
4 User Backop 2011-03-11 17 Fallow this link in order to add a new spied directory or to manage list, E

Applying Changes as
Click here to save all your changes for the Log Vault Service.
All the changes you have made locally will be sent to the Log Yault Service,
Log Yault Status .-
Running ©®@ ek and DECIDE Laog %ault is running.

| | i

|D0ne | |

11. Open the Click and DECiDE/localhost/Agents (or NetReport/localhost/Agents for earlier version)
sub-tree.

12. Navigate to a node with an asterix (*).
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13. Click Apply Changes.

B= Click and DECIiDE Management Console - [Console Root',Click and Decide' localhost', Agents',Flat File Parser*]

a File  Action ‘iew Favorites  Window  Help |;|i|l|

AN 7N

[_1 Consale Rioot

=] eclickand Decide Flat File Agent
El g locahost
Packages Server
? L& =Click and Decidefocalhost/Agents/Flat File Parser<
El 4 Agents Flat File Spies

Check Point (Real Time)*
Event Scheduler®

Flat File Parser*
& Microsoft WM
«# MetReport Communication®
y_:‘ Remote Microsoft W%
SNMP Trap Liskener®

E Swslog Parser®

Log ¥aulk
= Backups

Gurrent Spied Directory List

The files matching =.log’ of the directory 'C:\Program Files (x86)\Click and [ 7 Edit |
DECIiDE'NSILogs\Engine\Flatfile‘\Fortinet FortiGate' are spied. [/_IJ

Follow this link in order to add a new spied directory or to manage list. E

£, wizard Backup 2011-03-11 Applying Changes e
¥, Wizard Backup 2011-03-11
4 User Backup 2011-03-11 17 Click here to save all your changes far the flat file agent.

All the changes you have made locally will be sent to the flat file agent.

Agent Status

Stop | Running Agent is running.

| | i

|D0ne

14. Repeat step 12. and 13. for every agent with an asterix (*).

15. Close the Mangement Console.

D. Restore the Scheduled Tasks

For version 11 and later:

=

Open Web Portal: Start>All Programs>Click and DECiDE>Web Portal.

2. Click the Scheduled Tasks & Tasks tab.

3. Click '%.

4. Click Continue.

5. Click Browse....

6. Select the scheduled tasks configuration file d7tasks.xml (see Section 1.C.9) you have backed up.
7. Click Open.

8. Click Import.
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For earlier version:
1. Open the Services Management Console: Start>Administrative Tools>Services

2. Right click on Click and DECIDE Task Manager and select Stop

£} services =] S |

File  Action Wiew Help

L EENEEN DT

L, Services {Local) Marne = | Description | Skatus | Startup Type | Log On As | o
Lk Application Experience Processes ... Manual Local System
\":\) Application Host Helper Service Provides a...  Started Automatic Local System
-."';) Application Identity Determines. .. rarual Local Service
-."';) Application Information Facilitates ... rarual Local System
'51) Application Laver Gateway Service Provides s... Marual Local Service o
-.,':,) Application Management Processes i, Manual Local System
-.,‘::)_;ASF‘.NET Skake Service Provides ... Manual Metwark 5.
-.,"':,:)_;Background Inteligent Transfer Service Transfers ... rManual Local System
-S:)_;Base Filtering Engine The Base F... Started Automatic Local Service
-."';) Certificate Propagation Copies use,,, Started rarual Local System
'51) Click. and Decide Conneck Service Prowides re... Started Aukannatic Local System
-.,':L')_;CIick and Decide Export Manager Manages C... Started Aukarnatic Local System
-.,':L')_;CIick and Decide Filker Engine Manages r...  Started Aubomatic Local System
-.,‘:,) Click and Decide LEC Service Manages C... Started Automatic Local System
-."'::)_;Click and Decide Log Waulk Manages k...  Started Automatic Local System
-S;)_;Click and Decide Server Helpers Service Manages C... Started Automatic Local System

& Alick and Decide Task Manager Manages 5...  Started Aukornatic Loca £

y Stark o
5k Click and Decide Web Objects M Manages C... Started Aukaomatic Local System
5k Click and Decide XML Remate Cc E Provides s...  Started Aukarnatic Local System
(5L CNG Key Tsolation Rause The CHa k... Manual Local System
-SJ_;COM+ Event System Resrmte Supporks 5., Started Aukomnatic Local Service

i estar
(ELCOMYE System Application Manages ... fanual Local System
“ChComputer Browser &l Tasks ¥ | Maintains a... Disabled Local System
Lk Credential Manager - Provides ... Manual Local System
Lk Cryptographic Services I Provides Fo... Started Aukaomatic Metwark 5.,
{5LDCOM Server Process Launcher Properties The DCOM.,.  Started Automatic Local System
£k Desktop Window Manager Sessi I— Provides [,.,  Started Aukomatic Local System ;I

L Help

Extended >\ Skandard

|St0p service Click and Decide Task Manager on Local Computer | |

3. Restore the scheduled tasks configuration file d7tasks.xml (see Section 1.C.9) located in:
C:\Program Files\Click and DECIDE\BAI (by default).
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4. Inthe Services Management Console, right click on Click and DECIDE Task Manager and select Start.

L Services =] 5 |

File Action View Help

e | [FE .= Hm > mun

£, Services (Local) Mame | Description | status [ Startup Tvpe | Logonas | -
-.‘:(I?‘;Application Experience Processes ... Maral Local System
‘& Application Host Helper Service Provides a...  Started Butarnatic Local System
-.‘;'?‘;Application Identity Determines... GEWIE] Local Service
-.‘;'_’;Application Infarmation Facilitates ... GEWIE] Local System
-.‘;:?';Appli-:atic-n Layer Gateway Service Provides s... Maral Local Service o
-.‘;I?';Appli-:atic-n Managemenk Processes ... GEIEY Local System
£ .ASP.NET State Service Provides ... GEEY Metwork 5.,
\S('?';Background Inkelligent TransFer Service Transfers F... GEEY Local System
\,‘,}'?’;Base Filtering Engine The Base F... Started Auitannatic Local Service
{,‘;?’;Certificate Propagation Copies use.,.  Started GEEY Local System
{,‘;?';Click and Decide Connect Service Provides re... Started Automatic Local System
{,‘;?';Click and Decide Export Manager Manages C... Started Automatic Local System
{,‘;?';Click and Decide Filker Engine Manages r...  Started Automatic Local System
{,‘;?';Click and Decide LED Service Manages C... Started Automatic Local System
\,‘:‘;?’;Click and Decide Log Vault Manages k... Started Automatic Local System

&4 Click and Decide Server Helpers Service Manages C... Started Automatic Local Swstem

] Lo \ 1
».,‘,}" lick and Decide Web Objects Manager Stop Started Automatic Local System
-.,‘:‘E?‘;Click and Decide %ML Remote Configurati I bs s, Started Automatic Local System
-f;l?‘;CNG Key Isolation T G k... Manual Local System
-J,‘E?‘;COM+ Ewent System - ks 5... Started Automatic Local Service
-.‘;I?‘;COM+ System Application . st.. Maral Local System
. Computer Browser all Tasks b ns a.., Disabled Local System
-.‘;:?‘;Credential Manager m bs 5., Maral Local System
£ Cryptographic Services . —  psfo.. Started Automatic Metwork 5.,
-.‘:('?‘;DCOM Server Process Launcher Properties aM.,.  Started Automatic Local System
-.‘;:?';Desktnp Window Manager Session Mana T bsD,,,  Started Automatic Local System ﬂ

Extended }\ Standard

|Start service Click and Cecide Task Manager on Local Computer

5. Close the Services Management Console.
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Section 3: Check your configuration

A. Log Acquisition

1. Start the log treatment.

N

Open the Performance Counters: Start>Administrative Tools>Performance.

Click the + in the toolbar.

w

4. Select the NetReport Filter Engine Performance object and select All counters.

Add Counters EE |

" Use local computer counters
¥ Select counters from computer:

[+4RRO-W2003-32 |

Perfarmance object:
I M etRepart Filker Engine j

&l instances

" Select counters from list: * Select instances from lisk

# nelf proceszed I etF epart Filker Engine
# of nelif in error queue

# af nelf in quele

R ate of nelif processed

Add Explain

Close |

5. Click Add.

6. Click Close.
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7. Check that you don’t have any nelrf (Click&DECIDE events) in the error queue.

[ Performance

@ File Action ‘iew Favorites ‘Window  Help ‘-lﬁ’lﬂ

= = |3 @ 2

1000
a0
a0

400

200 /\

Lask 0 Average 0 Minirmum 0 Maximurm ]

Dwrakion 1:40

Color I Scale I Counker | Inskance I Parent | Chbiject | [ I |
1.000  # nelf processed MetRepart Fiker Engine - MetRepart Fiker Engine 3\,
1.000  # of nelf in error queue MetReport Filker Engine MetReport Filker Engine .
1.000  # of nelf in queue MetReport Filker Engine - MetReport Filker Engine 4.,

1.000  Rate of nelf processed MetReport Filker Engine - MetReport Filker Engine 4.,

Note: the engine queues are stored in the folder C:\Program Files\Click and
DECIDE\NSI\Error agent Storage. You can modify the destination of these files by changing the
registry value:
HKEY_LOCAL_MACHINE\SOFTWARE\NetReport\MC\Agents\Error\StoragePath.

You have to restart the Click & DECIDE Filter Engine service after any change

B. Log Insertion
1. Open Web Portal: Start>All Programs>Click and DECiDE>Web Portal.

2. Navigate to NSI Utilities/Database Status.
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3. Open the project for the category of the log you have acquired. For example: Firewall Statistics
Utilities.

(_ Click and DECIDE Web Portal - Menus - Windows Internet Explorer
G—; - |g hiktpe ) flocalhost/ dyvweb/Menu, asps j |E| |§| |§| Ib Bing |P "|

'i',_‘f’ Favarites ,& Click. and DECICE Web Portal - Menus |

L/l CL:ck&DEC:DE

Wb Server Configuration Firewall Statistics Utilities Size Modification Creation

MenLs .
ENSI Reports and Analysis i M 0 1/21/2010 S:14:15 PM 9/2f2004 10:43:02 AM

= =5 NST Utilities 2 - Nurnber of Records in the Firewall Tables 0 1/21/2010 5:20:02 P 9/2/2004 10:43:08 AM

& G2 Database Status 3 - Address Defirition Management 0 1/21/2010 4:07:20 PM 5f2/2004 10:43:08 AM
#OFireswall Statistics Utilities |

4 - Firewall Aqareqation Process Status 0 4/28/2010 4:57:31 PM  9/2/2004 10:43:08 AM

™ Click and DECIDE Awidit
@Pm}{\; Statistics Utilities

=MST Alert Management
Scheduled Tasks & Tasks
weh Part Configuration
Content Buider
Wb Server Administration

4. Openthe report 2 - Number of Records in the Firewall Tables.
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5. Enter the time interval corresponding to the date of your logs. For example, if you are parsing logs from
10 days ago, enter 10 in the first text box.

f> Click and DECIDE Web Portal - Menus - Windows Internet Explorer
6@ - |g hikkpe f flocalhost | dyvweb Menu, aspe j |E| |§| |§| Ib Bing |P "|

'i'j‘ Favarites g Click. and DECICE Web Portal - Menus |

N CL:ck&DEC:DE

Wwieh Server Configuration &y €29 & | Parameters ] Result Both
MEFILIS
2 - Mumber of Records in the Firewall Tables
. i
[+
=+ ENSI Reports and Analysis [ From: Today - X days |10|

= =5 NST Utilities

= &2 Database Status W To: Today - ¥ days fo

fOFirewal Statistics Utiities || I Start time: |5/6/2009 12:00:00 &M
™ Click and DECIDE Audit ¥ Stop time: |5/6/2010 11:59:50 PM
2 Proxy Statistics Utiities | — Frewall> (1grore for al): [iGhorE =

=MST Alert Management
Scheduled Tasks & Tasks
weh Part Configuration
Content Buider
Wb Server Administration

Output Format: & poF - Run |E. |%_|.

6. Click Run.
(_ Click and DECIiDE Web Portal - Menus - Windows Internet Explorer
GTLT:‘ * Iﬁ, hietpef flocalhost, dyvweb Menu, asps j | & | |‘f| | X | Ib Bing |53 '|
o7 Favarites i€ Click and DECIDE Web Portal - Menus
Web Server Configuration IARRE| % Patameters Result ] Eath =
Merus
2 - Number of Records in the Firewall Tables
E MSI Reports and Analysis 4% ﬂ
= E NSI Utilties i Number of records in the Firewall ables
= &2 Database Status
&:Irewa” StatIStIES Utllltles This report presents the total number of reconds =xising |nmaﬂmmm=?n_1mmauu|wm maost recent date and e with the
@C“Ek and DECIDE Audit aggregation status associated from within S Wednesday w 00:00:00 AM undl S Thursday May §, 2010 2 11-52:53 FM
™ Prowy Statistics Utiities T om— rmmm—
E MSI Alert Managerment o r— e
Scheduled Tasks & Tasks = o i) e
Web Part Configuration
Content Builder
Wweb Server Administration
Rt printason Trumduy by 8, 2090 ot 1648 Dmatibcard cramed wih & DICKEDIODET Fage i =
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7. Check that logs are inserted into the rawdata table.

C. Report Generation

1. Open the Scheduled Tasks panel: Start>Control Panel>Scheduled Tasks.

2. Right Click on Click and DECIDE Scheduled Dashboards and select Run.

& scheduled Tasks M=l E3
File Edit Wiew Favorites Tools Advanced Help ‘ ﬁ.
QBack - £ - (¥ |,':]Search |~ Falders | B 3 x ) | =
Address I@ Scheduled Tasks j a0
Mame = | Schedule | Mexk Fun Time | Last Ru,.. | Status | Last Result |
|21 4dd Scheduled Task
‘Click. and DECIDE NSI Scheduled 0AM... 1:00:004M ... Mever 0:0
@ Purge Alerts Tables el Taush JAM... 1:23:004M ... Mever D=0
5oL Firewall Alert - d Cisabled Mesver 00
Cuk
Copy
Delete
Rename
Properties
4 i
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3. Wait for the task to complete (it may take some time depending on the volume of your logs).

(& Scheduled Tasks [_ O]
File Edit Yew Favorites Tools Advanced Help | ﬂ"
() Back - €3 - ¥ | ) Search [ Folders | B 3 x K | -

Address I@ Scheduled Tasks j Go
Mame = | Schedule I Mexk Run Time I Last Ru. .. I Skakus I Last Result I
|2 add Scheduled Task

‘Click. and DECIDE MSI Scheduled Dashboards SRS n: 10 RRRS RTu e o1 IR FIu) B3 IR =Wy 1y 0::0

@ Purge &lerts Tables A 1:2348M.., 1:2300A4M ... MNewver 0w
iz S0 Firewall Alert Disabled Disabled Mesver 0::0

1| | i

4. Return to Web Portal (see Section 5.B).

5. Navigate to NSI Reports and Analysis/Published Report.
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6. Select the category of the log you have acquired. For example: Firewall.

(_ Click and DECIDE Web Portal - Menus - Windows Internet Explorer
G-D = |g, hiktpe ) flocalhost/ dyvwebMMenu. asps j |§| |§| |£| Ib Bing |£‘|L|

o.p Favarites (@8 Click and DECIDE Web Portal - Menus | |

@D Click&DECIDE

Web Server Configuration Firewall Size Modification Creation
MerLs
srl = Frewal Daly 100505 164,630 S/6/2010 5:02:25 PM S5/6/2010 5:02:23 FM

=2 E MSI Reports and Analysis
= & Published Reports
CFirewal
CAProwy
(&2 Dynamic Reports
&2 Forensic Analysis
&My Projects
= =5 NST Utilities
= &2 Database Status
™ Fireveall Statistics Utilities
™ Click and DECIDE Awidit
@F‘mxv Statistics Utilities
=MST Alert Management
Scheduled Tasks & Tasks
Wb Part Configuration

Content Builder
Web Server Administration

7. Check that a report has been generated. If you have inserted yesterday’s logs, the reports should contain
some data.

D. Event Viewer

1. Open the Event Viewer: Start>Administrative Tools>Event Viewer.
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2. Select the Application event log.

H Event Yiewer !EI E

File  Action Miew Help

&= LmEER R 2@

@ Event Wiewer (Local) Application 1

ﬂ gsfi::if:m Tvpe [ake Tirne Source _ak &
System (E)Information  5/6/2010 43909 PM  MSS0L$SOLEXPRESS {2y =

______ 1] Tnternet Explorer () Information  5/6/2010 4:16:39PM  MSS0L$SOLEXPRESS ()

&Warning 5/6/2010 4:14:31 PM Perflib Mor

&Warning 5/6/2010 4:14:31 PM Perflib Mor

&Warnlng 5/6/2010 4:14:30 PM Mor

rmakion 0 .and DECIDE Syslog Agent

@Infurmatiun 5/6/2010 3:01:02 PM Cllck and DECDE Swslog Agent  Mar

@Infurmatiun 5/6/2010 301:02 P Click and DECIDE Svslog Agent  Mor

@Infurmatiun 5/6/2010 301:02 P Click and DECIDE Svslog Agent  Mor

@Infurmatiun 5/6/2010 30057 PM Click and DECIDE Flat File Ag...  Mor

@Infurmatiun 5/6/2010 3:00:57 PM Click and DECIDE Flat File Ag...  Mor

@Infarmatian Slalz010 3:00:57 PM Click and DECIDE Flat File Ag...  Mor

@Infurmatiun 5/6/2010 3:00:57 PM Click and DECIDE Flat File Ag...  Mor

&Warning 5/6/2010 2:52:21 PM Click and DECIDE M3I Engine Mor

@Infurmatiun 5/6/2010 2:52:21 PM Click and DECIDE M3I Engine Mor

&Warning 5/6/2010 2:52:21 PM Click and DECIDE M3I Engine Mor
@Infurmatmn 5/6/2010 25221 PM Cllck and DECIDE M3I Englne Mar _

3. Check that there are no error from a Click and DECIDE process.
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